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This manual provides a comprehensive guide on how to visualise and analyse the scientific 
data acquired by the StAnD Meteor Camera Kit, dedicated to the detection of bright meteors 
(i.e. fireballs and bolides) during night-time. Calibration and fireball data are analysed using 
PASCAL, namely the PRISMA and StAnD All-Sky Camera Analysis Laboratory. The document 
provides installation instructions, a description of the main components of PASCAL, and a 
step-by-step guide to triangulate the three-dimensional trajectory and to determine the 
dynamics of a fireball observed by at least two PRISMA or StAnD stations. 
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1. Rudiments of Meteor Data Analysis 
The rationale behind the observational efforts of meteor and fireball networks such as 
PRISMA and StAnD is to determine the geometrical, physical, and orbital parameters of the 
observed meteoroids based on the precise tracking of the three-dimensional trajectory of 
the meteors (mostly fireballs and bolides) detected in the Earth’s atmosphere.  

These results enable us to understand whether meteorite fragments are expected to have 
fallen onto the ground and, most importantly, to estimate their area of fall, called 
strewn-field. Furthermore, gathering statistics of such events allows probing the population 
of Near-Earth Objects (NEOs) and their orbital distribution in the vicinity of the Earth’s orbit.  

Therefore, the primary scientific data from the PRISMA and StAnD networks consist of video 
recordings of fireballs and bolides (referred to as detections). A set of two or more 
detections of the same fireball is then called an event. Along with event data, all stations in 
the network collect calibration data to perform continuous positional (astrometry) and 
intensity (photometry) calibration of the sensors.  

All data from the PRISMA and StAnD networks can be analysed using PASCAL, the PRISMA 
All-Sky Camera Analysis Laboratory, an application specifically developed for this purpose by 
the authors of this document (INAF – Osservatorio Astrofisico di Torino) and written in IDL 
(Interactive Data Language, NV5 Geospatial Solutions).  

1.1. Analysis of Calibration Data 

The analysis of event data begins with the astrometric and photometric reduction of the 
videos, which involves determining the fireball’s position and intensity as a function of time. 
This is made possible by analysing the calibration dataset of each camera that detected the 
event. This dataset consists of 5-second exposure images acquired every 10 minutes 
throughout the night, in which stars up to magnitude +5 are typically visible, with an average 
of a few hundred stars per image (see also the Meteor Camera Kit Manual, Section 4.2.5).  

The measurement of the positions and fluxes of these stars, combined with a comparative 
analysis against high-precision astronomical catalogues, enables the determination of the 
camera’s astrometric and photometric calibration. This calibration consists of a set of 
mathematical relationships linking the measured quantities — namely, the stars’ positions on 
the focal plane (expressed in pixels) and their fluxes (expressed in analog-to-digital units, 
ADU, per second) — to their true positions in the sky, expressed in alt-azimuthal coordinates 
(altitude above the horizon, h, and azimuth with respect to the North, a) and their apparent 
magnitudes, m.  

Such mathematical relationships, and in particular the values of their parameters, are 
therefore derived from the analysis of the calibration data and then applied to the event 
data. It is worth noting that these parameters can vary from night to night or over longer 
timescales, often exhibiting seasonal variations driven by temperature changes. 

The calibration process enables the determination of the fireball’s position in the sky and its 
apparent magnitude from a single detection, expressed in standardised units that allow 
these measurements to be combined with those obtained from other stations in the 
network. Further details are provided in Barghini et al. (2018) and Barghini et al. (2019). 
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1.2. Analysis of Fireball Data 

Each fireball event detected by the PRISMA and StAnD networks (see also the Meteor 
Camera Kit Manual, Section 4.2.7) is analysed using a dedicated reduction pipeline 
comprising the following steps: 

1.​ Astrometric and photometric reduction of each detection within the event, applying 
the calibration results (see Section 1.1). This step returns the alt-azimuthal 
coordinates (h, a) and the apparent magnitude m as a function of time for the entire 
event duration, also referred to as the time of flight. 

2.​ Triangulation of the fireball’s atmospheric trajectory, by combining the 
measurements of the celestial coordinates (h, a) of the fireball from all detections. 
This process yields the three-dimensional trajectory of the meteoroid during its 
visible flight through the Earth’s atmosphere, usually expressed in terms of latitude, 
longitude, and altitude above ground level. Consequently, it is possible to estimate 
the most important physical observables of the event — namely, its speed (v) and 
absolute magnitude (M) — as functions of time, or alternatively, as functions of 
altitude. 

3.​ Fitting of the observational data to a dynamic model, which interprets the variations 
in speed and absolute magnitude as a function of several physical parameters. This is 
achieved by employing a system of non-linear differential equations that describe 
the physical processes governing the phenomenon. The parameters of this model are 
estimated through a fitting procedure, in which the model output is adjusted  to 
match the observational data. These parameters are directly related to the 
meteoroid’s pre-atmospheric physical quantities (including its mass, cross-section, 
size, and velocity). The results of the dynamic model can then be used to predict the 
evolution of these quantities throughout the fireball’s atmospheric flight — for 
example, to estimate the final mass of the meteoroid and to assess whether or not 
meteorite fragments are likely to be recovered on the ground. 

4.​ Computation of the meteoroid’s pre-atmospheric orbit by backward extrapolation of 
its atmospheric trajectory, correcting for the atmospheric drag and the Earth’s 
gravitational influence. This final step yields the orbital parameters of the meteoroid 
just prior to its encounter with Earth, enabling investigations into its source region 
within the Solar System. 

Further details on the event analysis performed on PRISMA data are provided in Gardiol et al. 
(2021). 

2. Installation of PASCAL 
PASCAL is currently distributed only for the Microsoft Windows operating system, and the 
installer is available for download on the StanD project website. After downloading, run the 
setup wizard by double-clicking the executable file (for example, PASCAL_setup-v1_1.exe). 
The user will be greeted with a welcome page (see Figure 1, left panel).  
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Figure 1 – Screenshots of the setup wizard for the PASCAL application. The left panel shows a screenshot of 
the wizard’s welcome page, while the right panel displays the installation page.  

  
 

The installation process is fully guided and consists of the following steps: 

1.​ Select Destination Location. The user will be prompted to select an installation 
directory for the application (by default, it will be installed in the 
AppData\Local\Programs directory of the current user’s profile). 

2.​ Select Components. The user can choose whether to install the application 
workspace (required to run PASCAL) and some test data. If this is the first time 
installing PASCAL, installing the workspace is essential. It is also highly recommended 
to install the test data, as this allows immediate testing of the application’s 
functionality and provides an example of how data should be organised within the 
workspace. 

3.​ Select Additional Tasks. The user can choose whether or not to create a desktop 
shortcut for PASCAL. 

4.​ Select Workspace Location. If the user chooses to install the workspace, the installer 
will prompt for its location. The workspace consists of a main directory, and the user 
can select where this directory will be created (by default, it is placed in the 
Documents folder of the current user’s profile) and choose its name (by default, it will 
be named PASCAL). 

5.​ Ready to Install. A summary of all selected options is presented to the user (see 
Figure 1, right panel). 

After clicking the Install button on the last page, the application will be installed. At the end 
of the installation process, the user can choose whether or not to display the ReadMe file 
and/or launch PASCAL immediately. 

2.1. PASCAL Workspace 

The PASCAL workspace contains all the essential components and files required to run the 
application. It will be installed at the location specified on the Select Workspace Location 
page of the PASCAL setup wizard. To access it, navigate to the path chosen during 
installation. The workspace has the following folder structure:  
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●​ PASCAL\archive\. This directory stores the compressed output of the data 
processing performed by the PRISMA pipeline, formatted as .tar.gz archives for 
long-term storage. Even if test data were installed, this directory will initially be 
empty. It is used only when running the PASCAL submodule for the complete data 
processing available through the File > Data process menu (see Section 3.2.4).  

●​ PASCAL\atmosphere\. This directory contains the atmospheric and geomagnetic 
data, as well as external procedures required for running the dynamic model module 
during event analysis. It is used only when running the PASCAL submodule for the 
complete data processing available through the File > Data process menu (see Section 
3.2.4).  

●​ PASCAL\captures\. This directory contains the calibration data (captures), organised 
with a separate folder for each station (named using the station code, e.g. ITPI01). 
Within each station folder, the data are grouped by month of acquisition (e.g. 
202505) and stored in FITS file format. If the Test Data component was selected 
during installation, this directory will contain some test calibration data.  

●​ PASCAL\calibrations\. This directory contains the results of the calibration data 
processing, with the same structure as the captures folder. Result files are provided in 
TXT and PDF formats. It is used only when running the PASCAL submodule for the 
complete data processing available through the File > Data process menu (see Section 
3.2.4). If the Test Data component was selected during installation, this directory will 
contain the result files of the calibration test data.  

●​ PASCAL\events\. This directory contains the fireball (event) data, organised into 
folders by month of acquisition (e.g. 202505). Within each monthly folder, the data 
for each event are stored in a dedicated folder named with the event code (e.g. 
20250501T235924_UT). Inside each event folder, the data from individual detections 
are each stored in a separate subfolder named after the corresponding detection 
code (e.g. PINOTORINESE_20250501T235924_UT). If the Test Data component was 
selected during installation, this directory will contain some test event data.  

●​ PASCAL\results\. This directory contains the results of the event data processing, 
with the same structure as the events folder. Result files are provided mainly in TXT 
and PDF formats. It is used only when running the PASCAL submodule for the 
complete data processing available through the File > Data process menu (see Section 
3.2.4). If the Test Data component was selected during installation, this directory will 
contain the result files of the event test data.  

●​ PASCAL\settings\. This directory contains all the configuration files required to run 
PASCAL and its submodules. Its contents are organised as follows:  

○​ PASCAL\settings\configurations\. This directory contains all configuration 
files and masks for each station. If the Test Data component was selected 
during installation, this directory will also contain the configuration files and 
masks required to process the test data.  

○​ PASCAL\settings\solutions\. This directory contains astrometric and 
photometric calibration files (also referred to as solutions) to be used for the 
analysis of the fireball recordings from each station. If the Test Data 
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component was selected during installation, this directory will also contain 
the solutions required to process the test data.  

○​ PASCAL\settings\logos\. This directory contains the logos of PASCAL and of 
the PRISMA and StAnD projects.  

○​ PASCAL\settings\templates\. This directory contains some template files. It is 
used only when running the PASCAL submodule for the complete data 
processing available through the File > Data process menu (see Section 3.2.4).  

○​ PASCAL\settings\configuration.ini. This file contains all configuration 
parameters and workspace paths required to run the PASCAL application. If 
the Application Workspace component was selected during installation, the 
configuration file is automatically adjusted to match the local workspace path 
specified by the user. In this case, the path to the configuration file is stored in 
the current user’s Windows Registry and will be automatically loaded each 
time PASCAL is launched; otherwise, the user will be prompted to select the 
configuration file manually.  

○​ PASCAL\settings\solutions.ini. This file contains a two-column list of the 
stations recognised by PASCAL. Each row represents a station: the first column 
contains the station code (e.g. ITPI01), and the second column contains the 
station name (e.g. PINOTORINESE). When opening a new image (calibration or 
fireball data), PASCAL verifies that the image FITS header reports a code and 
name matching one of the entries in this file. When adding data from a new 
station, the user must edit this file and add a new row for that station.  

○​ PASCAL\settings\catalog.txt. This file contains the astrometric and 
photometric catalogue of stars used for the analysis of calibration data.  

3. PASCAL Interface Description 
To launch the PASCAL application, search for and select PASCAL from the Windows Search 
bar on the taskbar, or double-click the PASCAL desktop icon if you created a shortcut during 
installation. At startup, a welcome window will appear (as shown in Figure 2, left panel); click 
the PASCAL button to proceed. A second, similar window will then appear (Figure 2, right 
panel); click the Click To Continue button to complete the launch process and start PASCAL.   
 

Figure 2 – Screenshots of the welcome windows of the PASCAL application launcher. 
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Figure 3 – Screenshot of the main window of the PASCAL application, showing a calibration frame from the 
StAnD station in Nice (FRCA20 - Nice, Collège Frédéric Mistral).  

 

3.1. Main Window 

If PASCAL launches successfully, the user will be greeted with the main application window, 
as shown in Figure 3. If the application cannot locate the configuration.ini file, a file browser 
window will prompt the user to select a valid one. If the selected configuration file has an 
incorrect format, PASCAL may close unexpectedly, so caution is advised when manually 
editing this file.  

The main window presents several components, highlighted in Figure 3 and listed in the 
following. 

3.1.1. Main Menu Bar 

It provides access to all the main modules, functions, and options of PASCAL, organised into 
seven sub-menus (File, Logo, Mask, Astrometry, Stars, Positions, and Photometry). All entries 
are described in detail in Section 3.2 to Section 3.5. 

3.1.2. Mode Dropdown Menu 

It displays the current mode of the widget, i.e. the type of image currently shown. Images 
can be from calibration data (in which case the dropdown menu displays Capture) or from 
fireball data (in which case it displays Detection). The current mode determines which 
PASCAL functionalities are active. The user can change the mode by selecting the desired 
option from this dropdown menu; however, note that detections must follow a strict folder 
structure according to the Freeture format (see Section 3.2.2). 
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3.1.3. Current File 

A text box displaying the full path to the image file currently loaded and displayed in 
PASCAL. The user can edit this path to load a different image. After editing it, the user must 
press Enter on the keyboard to load the new image. 

3.1.4. Next/Previous File 

Two buttons to browse to the previous (<<) and next (>>) image FITS files in the current 
directory.  

3.1.5. Play/Save Movie 

A combo widget to play and save an animation by browsing through the image FITS files 
available in the current directory. In the left text box, the user can specify the number of 
frames to include in the animation (e.g. entering 50 will include the next 50 frames relative 
to the current one), optionally followed by a comma and the number of milliseconds to set 
as the delay between consecutive frames (e.g. entering 50,10 will create an animation of 50 
frames with each frame displayed for 10 ms). 

Clicking the Play button displays the animation in the widget only. Clicking the Save button 
plays the animation in the widget and, once completed, prompts the user to choose a path 
and filename to save the output as a GIF file, along with a PNG image showing the integrated 
track resulting from the animation. 

3.1.6. Main Draw Window 

It is the main component of the application, where the current image is displayed in full size 
and grayscale. The image visualization settings can be adjusted using the image sliders (see 
Section 3.1.9) and the display option buttons (see Section 3.1.15). 

When moving the mouse over the window, the (x, y) coordinates of the cursor on the image 
are shown in the pixel position text boxes (see Section 3.1.11), and the corresponding image 
pixel value is displayed in the pixel value text box (see Section 3.1.12). 

If the user clicks on the window with the left mouse button, the center of the zoom box (g) is 
moved to the clicked position, and the zoomed view window (h) is updated accordingly. 

3.1.7. Zoom Box 

A blue box superimposed on the main draw window (see Section 3.1.6) that highlights the 
portion of the image displayed in the zoom draw window (see Section 3.1.8). The size of the 
zoom box can be adjusted using the zoom slider (see Section 3.1.10). 

3.1.8. Zoom Draw Window 

A square draw window displays the portion of the image enclosed by the zoom box (see 
Section 3.1.7), using the same greyscale and display options as the main draw window (see 
Section 3.1.6). Hovering or clicking with the mouse in this window produces the same effects 
as in the main draw window. 
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3.1.9. Image Sliders 

Two sliders to adjust the minimum and maximum values for the current image displayed in 
both the main and zoom draw windows. Since PRISMA and StAnD network images are stored 
in 12-bit format, the default range is from 0 to 4095 ADU. 

3.1.10. Zoom Settings 

A slider that allows the user to adjust the size of the zoom box highlighted by the blue 
square in the main draw window (see Section 3.1.6) and displayed in the zoom draw window 
(see Section 3.1.8). The slider ranges from 5 (maximum half-size of 15 × 25 = 480 pixels) to 0 
(minimum half-size of 15 × 20 = 15 pixels).  

Regardless of the slider value, selecting the Full button expands the zoom box to include the 
full image while preserving its square aspect ratio. 

3.1.11. Pixel Positions 

Two textboxes that report the x and y coordinates of the pixel currently under the cursor, 
either in the main draw window or in the zoom draw window. 

3.1.12. Pixel Value 

A textbox that reports the image value of the pixel currently under the cursor, either in the 
main draw window or in the zoom draw window. 

3.1.13. Zoom Centre 

Two textboxes that report the x and y coordinates of the centre of the currently selected 
zoom, as highlighted by the blue square in the main draw window (see Section 3.1.6) and 
displayed in the zoom draw window (see Section 3.1.8). 

3.1.14. Geographical Coordinates 

Three textboxes that display the geographical coordinates of the current image (latitude, 
longitude, and altitude above ground level), as read from the FITS file header. These values 
are also used for ephemeris computations (see Section 3.5 and Section 3.6) and to compute 
the equatorial coordinates reported in the corresponding textboxes (see Section 3.1.18). The 
textboxes are editable, allowing the user to correct inaccurate coordinates from the FITS 
header. To make such modifications effective, the user must press Enter on one of the three 
textboxes. 

3.1.15. Display Options 

Three toggle buttons allow the user to adjust the display options of the current image in 
both the main and zoom draw windows: 

●​ Negative: inverts the grayscale palette, switching from a black to a white background;  

●​ Log scale: applies a logarithmic stretch to the color scale;  

●​ Interpole: smooths the image using a sub-pixel interpolation filter. 

 

11 
This project has been funded with support from the European Commission. This publication reflects the 
views only of the author, and the Commission cannot be held responsible for any use which may be made 
of the information contained therein. Project No. KA220-SCH-F3BE36BB. 



 
 

3.1.16. Calibrate Button 

A toggle button enables the computation of celestial coordinates based on the current 
astrometric solution (see Section 3.5). The resulting coordinates are displayed in the 
textboxes to the right of the button, showing both the horizontal coordinates (see Section 
3.1.17) and the equatorial coordinates (see Section 3.1.18). The button will automatically 
deselect if the astrometric solution is modified manually or if a different image is loaded. 

3.1.17. Horizontal Coordinates 

Two textboxes that report the values of the horizontal coordinates, azimuth and zenith 
distance (z or zd, which is the angle complementary to the altitude h), of the pixel currently 
under the cursor according to the current astrometric solution, if the Calibrate button (see 
Section 3.1.16) is selected. 

3.1.18. Equatorial Coordinates 

Two textboxes that report the values of the equatorial coordinates, right ascension 
(indicated as ra or α) and declination (dec or β), of the pixel currently under the cursor 
according to the current astrometric solution, if the Calibrate button (see Section 3.1.16) is 
selected. 

3.1.19. Time and Exposure 

Three textboxes that report the timing data for the current image, namely the UTC date and 
time, the Julian Date, and the exposure time of the image (in seconds). 

3.2. File Menu 

Through this menu, the user can carry out some basic operations and to launch the Data 
process submodule of PASCAL for the complete analysis of PRISMA and StAnD data. 

3.2.1. Load Config 

This menu item allows the user to browse, select, and load a new configuration file, or a 
new version of the current one, replacing the current PASCAL settings (see Section 2.1). Once 
clicked, a file browser dialog will open to select an INI file. If the chosen file is not in the 
correct format, PASCAL may close unexpectedly; therefore, caution is advised when manually 
editing the configuration file. 

3.2.2. Open Detection 

This menu item allows the user to load a frame from a Freeture detection of a fireball into 
PASCAL. After clicking the button, a file browser dialog will open to select an FITS file.  

A Freeture detection is stored in a directory following the convention: 

NAME_YYYYMMDDTHHMMSS_UT (e.g. NICE_20250113T222012_UT) 

The same naming convention applies to events (i.e. the collection of two or more detections 
of the same fireball recorded by different stations) but without the station name prefix: 

YYYYMMDDTHHMMSS_UT (e.g. 20250113T222012_UT) 
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It should be noted that two stations of the network may detect the same fireball at slightly 
different starting times; therefore, the time reported in the event code may differ by a few 
seconds from those reported in the detection codes of the same event. 

For a detection to be correctly loaded into PASCAL, the directory must comply with the 
standard Freeture structure; otherwise, the detection will not be loaded in PASCAL. In 
particular, the folder must contain the following mandatory elements: 

●​ fits2D: a folder containing the detection frames, organized as individual FITS files 
named frame_XXX.fit (e.g. frame_000.fit, frame_001.fit, … frame_253.fit); 

●​ positions.txt: a three-column TXT file reporting the (x,y) positions of the fireball for 
each frame where it was detected by Freeture. The columns are, in order: frame 
number, (x, y) coordinates, and UTC date/time string. For example:​
[...]​
191               (622;456)                 2025-03-03T03:29:18.0532 

192               (624;452)                 2025-03-03T03:29:18.0866 

193               (626;448)                 2025-03-03T03:29:18.1198​
[...] 

When opening a detection, the user must select a starting frame. Afterwards, it is possible to 
browse through all the detection frames using the Next/Previous buttons (see Section 
3.1.4), or by directly editing the frame number in the Current file textbox (see Section 3.1.3).  

Loading a detection enables the Positions menu (see Section 3.7), which allows the user to 
view and edit the contents of the positions.txt file in order to analyse the apparent path of 
the fireball in the night sky as recorded by the all-sky camera. 

3.2.3. Open Capture 

This menu item allows the user to load a calibration image into PASCAL. After clicking the 
button, a file browser dialog will open to select a FITS file. 

For this option, the file does not need to follow any specific naming convention. In general, 
any image saved in FITS format can be loaded into PASCAL through this option, provided that 
its header contains the following mandatory keywords: 

●​ TELESCOP: the station name (e.g. NICE); 

●​ DATE-OBS: the UTC date and time of the observation in FITS format (e.g. 
2025-03-03T03:29:18.0532); 

●​ EXPOSURE: the exposure time of the image, expressed in seconds; 

●​ SITELAT and : the geographic latitude of the station, expressed in decimal degrees; 

●​ SITELONG:  the geographic longitude of the station, expressed in decimal degrees; 

●​ SITEELEV: the altitude of the station, expressed in metres above the sea level. 

If any mandatory keyword is missing, the image will not be loaded and an error message will 
be displayed, specifying the missing entry. 

In addition, the station name reported in the TELESCOP keyword must be listed in the 
solutions.txt file (see Section 2.1); otherwise, the image will not be opened and the user will 
be prompted to add the missing station to that file. 
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Figure 4 – Screenshots of the PASCAL Data Process submodule window. The left panel shows the window 
when selecting calibration data processing and the right panel displays the event processing, both using the 
test data available with the PASCAL installer. 

  

3.2.4. Data Process 

This menu item launches the Data Process submodule of PASCAL, which opens a secondary 
window providing a graphical interface for executing the PRISMA data analysis pipeline. A 
screenshot of this window is shown in Figure 4. 

If the user selects either the calibration or the event module, the corresponding options will 
become available. The function of each option is briefly described in the Process description 
textbox at the bottom of the window when hovering over it with the mouse. A more 
in-depth overview of the PRISMA pipeline and its functionalities can be found on the GitLab 
repository of the source code and its Wiki page. 

The analysis target can be defined using the two Target textboxes (and their corresponding 
dropdown lists) located in the upper part of the window, depending on which module is 
currently selected: 

●​ Calibration module: 

○​ The first line must be set to the camera code (e.g. FRCA20). 

○​ The second line must be set to the day (e.g. 20250310) or month (e.g. 
202503) of the data acquisition to be processed. 

●​ Event module: 

○​ The first line must be set to the event code (e.g. 20250303T032917_UT). 

○​ The second line may be optionally set to the detection code (e.g. 
NICE_20250303T032917_UT). If not set, the program will include all valid 
detections found inside the event directory. 

The Search button, located on the right side of the target selection area, performs an 
automatic search of the data currently available in the PASCAL workspace and populates the 
two dropdown lists accordingly. 
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3.2.5. Exit 

This button closes PASCAL. Alternatively, the application can also be closed using the “X” 
button in the top-right corner of the window. 

3.3. Logo Menu 

This menu becomes active only after a valid image has been loaded into PASCAL. Through 
this menu, the user can show or hide the project’s logo, as well as the positional and timing 
information, on the zoom draw window. These graphic elements will be also included in the 
exported track image and GIF animation (see Section 3.1.5). 

3.3.1. Show Logo 

This menu item allows the user to display the project’s logo (either PRISMA or StAnD) in the 
bottom-right corner of the zoom draw window. An example of how the logo appears in the 
PASCAL interface is shown in Figure 5. 

3.3.2. Show Info 

This menu item allows the user to display the station code and name in the top-left corner 
of the zoom draw window, and the date and time of acquisition of the current image on a 
second line right under it. An example of how this information appears in the PASCAL 
interface is shown in Figure 5.  
 

Figure 5 – Screenshot of the main window of the PASCAL application, showing a calibration frame from the 
StAnD station in Nice (FRCA20 – Nice, Collège Frédéric Mistral). The project’s logo and the location and timing 
information are displayed by enabling the corresponding options in the Logo menu. 
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3.3.3. Import Logo 

This menu item allows the user to load a new logo that will be displayed when the 
corresponding option is active (see Section 3.3.1). It includes three sub-options that allow 
loading different logo versions: 

●​ Black logo: imports the version of the logo that will be displayed on a black 
background (when the Negative button is unchecked); 

●​ White logo: imports the version of the logo that will be displayed on a white 
background (when the Negative button is checked); 

●​ Both logos: imports both versions of the logo from one file (to be used when the logo 
has no separate black and white versions) that is assumed to have a transparent 
background. 

3.4. Mask Menu 

This menu becomes active only after a valid image has been loaded into PASCAL. Through 
this menu, the user can load and visualize a mask (similar to the detection mask described in 
the Meteor Camera Kit Manual, Section 4.3.1) and a superflat. The latter is a composite 
image that can be used to reduce spatial noise, particularly in calibration frames, by 
suppressing the visualization of hot and dead pixels. It can also be computed directly through 
an option available in this menu. 

The use of a mask and a superflat image is recommended when performing the astrometric 
calibration of images (see Section 3.5 and Section 3.6), but they will be silently ignored 
during the fireball position and photometric analysis (Section 3.7 and Section 3.8). 

3.4.1. Load Mask 

This menu item allows the user to load a mask BMP file, similar to the one discussed for the 
Freeture configuration in the Meteor Camera Kit Manual, Section 4.3.1. In summary, the 
mask file is an image with the same dimensions as the sensor under consideration (1324 × 
1324 pixels for the new-generation StAnD stations), where a pixel value of 0 (black) marks 
regions to be masked (i.e. excluded from all subsequent computations), and a value of 1 
(white) marks regions to be preserved. 

When a new mask is loaded through this menu item, it will be automatically displayed, and 
the Show mask option (see Section 3.4.2) will be checked by default. 

If the Test Data component was selected during the installation of PASCAL (see Chapter 2), 
example mask files are available in the directory PASCAL\settings\configurations\ for the 
StAnD stations included in the installed dataset. 

Using this option allows, most importantly, the masking of the portion of the image close to 
the horizon when searching for stars (see Section 3.6), which is typically affected by light 
pollution from the surrounding environment and may otherwise cause false positives in the 
star search algorithm. 
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3.4.2. Show Mask 

This menu item allows the user to show (if checked) or hide (if unchecked) the mask 
currently loaded in the main and zoom draw windows of PASCAL. If no mask is loaded (i.e. 
the Load mask item is unchecked; see Section 3.4.1), clicking this item will have no effect. 

In addition to controlling the mask visibility, the toggle status of this item also determines 
whether the mask is considered in the options of the Astrometry and Stars menus (e.g. 
whether the mask is applied during the star-finding process; see Section 3.5 and Section 3.6). 

3.4.3. Compute Flat 

This menu item allows the user to compute a superflat image using the data contained in the 
directory of the image currently loaded in PASCAL. After selecting this option, the user will be 
prompted, through a file browser, to select a series of FITS files from the current directory. 
The recommended selection includes at least ten images acquired under good weather 
conditions and with the Moon below the horizon. These conditions can be verified before 
selecting this option through a simple visual inspection, by browsing the images (typically 
calibration frames) using the Next/Previous buttons (see Section 3.1.4). 

From the selected images, PASCAL will compute a median frame that ideally encloses the 
relative response of each pixel. Once the computation is complete, the user will be prompted 
to choose a path and filename to save the resulting superflat image as a new FITS file. If 
needed, it can be visualized as a standard FITS image by loading it into PASCAL as a capture. 

To improve the results of the superflat computation, it is recommended to perform this 
operation with an appropriate mask loaded and visible, by checking the first two options of 
the Mask menu (see Section 3.4.1 and Section 3.4.2). 
 

Figure 6 – Comparison between the “raw” and “flat” versions of a calibration image acquired by the StAnD 
station in Nice (FRCA20 – Nice, Collège Frédéric Mistral) during the night of 02/03/2025. The flat correction 
effectively removes the influence of nearby lights on the horizon, most stray light (including that caused by 
internal reflections within the optical system), and hot pixels. In the “flat” version, stars become much easier 
to identify.​
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3.4.4. Load Flat 

This menu item allows the user to load a superflat image corresponding to the image 
currently loaded into PASCAL. The normalization to the selected superflat is performed 
through a pixel-wise division of the image by the superflat. We refer to the normalized 
image as “flat” because the resulting sky background will appear uniform and hot and dead 
pixels will be corrected.  

The flat version of the image can be displayed instead of the original (“raw”) version by 
checking the Show flat item (see Section 3.4.5). When a new superflat is loaded through this 
menu item, the flat version of the image will be automatically displayed, and the Show flat 
option will be checked by default. An example of the comparison between the “raw” and 
“flat” version of the same calibration image is shown in Figure 6.  

3.4.5. Show Flat 

This menu item allows the user to show (if checked) or hide (if unchecked) the flat version 
of the current image, computed using the currently loaded superflat, in the main and zoom 
draw windows of PASCAL. If no superflat is loaded (i.e. the Load flat item is unchecked; see 
Section 3.4.4), clicking this item will have no effect. 

In addition to controlling the visibility of the flat image, the toggle status of this item also 
determines whether the superflat correction is applied within the options of the Astrometry 
and Stars menus (see Section 3.5 and Section 3.6), that is, whether flat normalization is 
applied during the star-finding process. 

3.5. Astrometry Menu 

This menu becomes active only after a valid image has been loaded into PASCAL. Through 
this menu, the user can enable, toggle and execute all the astrometric computations on the 
current image. It serves as the main interface for loading, displaying, editing, and saving the 
astrometric solution. In calibration images, this solution will be based on the positions of 
stars detected in the image. For this reason, many of the items in this menu are interrelated 
with those of the Stars menu (see Section 3.6). 

For the sake of clarity, the term solution refers to the set of physical parameters used to 
convert the coordinates of a source measured in instrumental units on the focal plane,  that 
is, (x, y) in pixel units,  into sky angular coordinates, such as horizontal or equatorial 
coordinates. In some cases, the term solution may also refer to the photometric solution, 
which similarly consists of a set of parameters used to convert the intensity of a source 
measured in instrumental units (such as ADU per second) on the focal plane into apparent 
magnitude units. 

3.5.1. Activate 

This menu item enables all other items in the Astrometry menu – except for the Load 
solution (see Section 3.5.2) and Reset solution (see Section 3.5.3) items, which are always 
active – or disables them when clicked a second time. If no solution file has been previously 
loaded, PASCAL will automatically load a predefined solution and display a warning message. 
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3.5.2. Load Solution 

This menu item allows the user to load a new astrometric solution in the form of a TXT file 
with a predefined and fixed format. After clicking this item, a file browser will prompt the 
user to select the desired file. A solution file can be also loaded before activating the 
astrometry module (see Section 3.5.1). 

If the Test Data component was selected during the installation of PASCAL (see Chapter 2), 
example solution files are available in the directory PASCAL\settings\solutions\ for the 
StAnD stations included in the installed dataset. Note that these solution files are those 
produced by the complete data processing pipeline (see Section 3.2.4) and may slightly differ 
from those generated using the Save solution item (see Section 3.5.6). Both file versions are 
fully compatible with PASCAL. 

An example of a solution file is shown in Figure 7. The first six lines of the file contain 
important metadata, listed in the following order: the station code and date of the solution; 
the configuration file used by the data processing pipeline to compute the solution; the 
astrometric model and the number of stars used in the computation; and the standard 
deviation of the residuals in azimuth and zenith distance derived from the position of the 
stars used to compute the solution. If the solution was exported through PASCAL, the header 
will contain three additional lines related to the photometric calibration, listed in the 
following order: the standard deviation of the magnitude residuals, the zero-point 
magnitude, and the correction factor associated with the photometric solution. 

As shown in Figure 7, each line following the header reports the value of the parameters of 
the solution (and the corresponding error, if provided) whose physical meaning can be 
understood through the use of the Astrometry submodule of PASCAL (see Section 3.5.4). 
 

Figure 7 – Screenshot of the content of a solution file for the the StAnD station in Nice (FRCA20 – Nice, 
Collège Frédéric Mistral), provided with the PASCAL installation is the user selected the Test Data component. 
The solution was computed through the complete data analysis pipeline over a daily statistics (from the night 
of 02/03/2025) of about 18 thousand stars. 
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3.5.3. Read Solution 

This menu item allows the user to reset the astrometric model and the parameters of the 
solution (for both astrometry and photometry) to their default values. An informational 
message will be displayed if the pre-existing solution was loaded or modified by the user.  

3.5.4. Edit Solution 

This menu item launches the Astrometry submodule of PASCAL, which opens a secondary 
window providing a graphical interface for modifying the parameters of the current 
astrometric solution. A second click on this menu will close the currently opened submodule 
and destroy the window. Some screenshots of this window, shown for three different 
astrometric models loaded, are provided in Figure 8. 

The various components of the window of this submodule are as follows: 

1.​ Astrometric model: a dropdown menu allowing the user to select the astrometric 
model from four available options. The supported models are: 

a.​ proj_asin1 – the standard fish-eye projection; 

b.​ proj_exp1 – a symmetric projection with an exponential distortion model; 

c.​ proj_rotz_exp1 – an extension of the previous model including two centres of 
symmetry (the optical centre and the zenith direction); 

d.​ proj_rotz_exp1_asym – an extension of the previous model that incorporates 
an asymmetric distortion of the azimuth angle on the focal plane. 

 

Figure 8 – Screenshots of the Astrometry submodule of PASCAL opened for three different solutions. The 
numbers shown in the left panel correspond to the description provided in Section 3.5.4. Depending on the 
selected astrometric model, a different number of parameter rows will be activated. From left to right, the 
models increase in complexity and accuracy, as shown by the decreasing values of the astrometric residuals.​
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2.​ Astrometric model description: a textbox displaying a short description of the 
current astrometric model. 

3.​ Parameters table: a table displaying the values of all the parameters included in the 
current astrometric solution. Each row reports, from left to right, the parameter 
name (i.e. symbol or abbreviation), its current value and measurement unit, 
together with a set of two buttons and an editable textbox allowing the user to 
increase or decrease the current value according to the step specified in the textbox. 
When hovering the mouse over the parameter name, its description is displayed in 
the textbox at the bottom of the window.  

4.​ Astrometry information: three textboxes reporting the value of some parameters 
summarizing the quality of the astrometric current solution. From left to right, these 
are: the number of stars used to determine the solution (ns), the standard deviation 
of the azimuth residuals (s_az), and the standard deviation of the zenith-distance 
residuals (s_zd), both expressed in arcminutes. Lower values of these standard 
deviations indicate a better-quality astrometric solution, as they represent the 
average offset between the actual position of a source and the position computed by 
the astrometric model. These values are displayed only if the solution was computed 
from a fit over a set of stars associated with catalogue positions, and therefore the 
Match stars option of the Stars menu is active (see Section 3.6.5), or if it was loaded 
from a solution file produced by PASCAL (see Section 3.5.2). If the user modifies the 
solution manually (e.g. through the parameters table), these values will be erased.  

5.​ Photometry information: three textboxes reporting the value of the photometric 
parameters associated with the current solution. From left to right, these are: the 
photometric zero-point magnitude (C), the photometric correction factor for the 
magnitude scaling (g), and the standard deviation of the magnitude residuals 
(s_mag). The zero-point magnitude C represents the instrumental magnitude, 
defined as  , of a source with apparent magnitude 𝑚

𝑠 
=  − 2. 5 · 𝑙𝑜𝑔

10
(𝐹

𝑠
)

 (where Fs is the instrumental flux of said source, typically expressed in 𝑚 =  0
ADU/s units). Knowing the values of C and g, one can estimate the apparent 
magnitude of a source as .  𝑚 =  𝐶 +  𝑔 · 𝑚

𝑠

The standard deviation of the magnitude residuals indicates the precision of this 
conversion based on the current values of C and g shown in the textboxes. Lower 
values of this standard deviation correspond to a higher-quality photometric 
solution. These values are displayed only if the Match stars option of the Stars menu 
is active (see Section 3.6.5) or if the solution was loaded from a solution file 
produced by PASCAL (see Section 3.5.2). 

6.​ Parameter description: a textbox displaying the description of the parameter over 
which the user’s mouse is currently hovering. 

3.5.5. Fit Solution 

This menu item allows the user to automatically determine the optimal values of the 
solution parameters (for both astrometry and photometry calibrations) based on the 
current match between the detected stars and their catalogued positions and magnitudes 
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(see Section 3.6.5). This procedure is typically referred to as a “fit”, hence the name of this 
menu item.  

This option will be available only if the Match stars item of the Stars menu is selected (see 
Section 3.6.5). Moreover, for the fit to be successful, the number of matched stars must 
exceed the number of parameters in the current astrometric model. It is recommended to 
have at least several tens of matched stars before attempting to fit the solution. 

If the fit is successful, the values of the astrometric and photometric parameters displayed in 
the Astrometry submodule will be updated to the optimal solution (see Section 3.5.4), and all 
related options and submodules will be refreshed accordingly. The quality of the resulting 
solution can be assessed by examining the astrometric and photometric residual plots (see 
Section 3.5.9 and Section 3.5.10). The standard deviations of these residuals are reported in 
the corresponding textboxes of the Astrometry submodule (see Section 3.5.4). If the fit fails, 
an error message will be displayed, and the current solution will remain unchanged. 

3.5.6. Save Solution 

This menu item allows the user to save the values of the current solution’s parameters – 
both astrometric and, if available, photometric – into a TXT file that can later be loaded back 
into PASCAL (see Section 3.5.2). After clicking this item, a file browser window will open, 
prompting the user to select a location and filename for saving the solution as a TXT file. 

3.5.7. Show Alt/Az Grid 

This menu item enables the visualization of the alt-azimuthal grid on both the main window 
and the zoom window of PASCAL, based on the currently loaded astrometric solution. 
Clicking the item a second time hides the grid. The grid is displayed as thin dashed lines in 
white (or black if the Negative option is selected; see Section 3.1.15), as shown in Figure 9. 

The lines radiating from the centre (corresponding to the zenith direction and/or the optical 
centre, depending on the selected astrometric model) represent azimuth isolines, while the 
concentric circles represent zenith distance isolines. In the zoom window, each isoline is 
labelled with its corresponding alt-azimuth coordinate. 

Users should note that generating and displaying the grid requires a non-negligible amount 
of computation time. Consequently, browsing through images may be slower than expected 
while this option is active. 

3.5.8. Hide Grid Label 

This menu item disables the visualization of the alt-azimuth grid labels when the Show 
alt/az grid option is active (see Section 3.5.7). Clicking the item a second time restores the 
labels visualization. 

3.5.9. Plot Astrometry 

This menu item allows the user to plot the azimuth (top panel) and zenith distance (bottom 
panel) residuals between the measured and catalog positions of the stars identified in the 
current calibration image (see Section 3.6). Consequently, this item is available only when 
the Match stars option of the Stars menu is active (see Section 3.6.5). The plots are displayed 
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in a new graphical window, from which the user can edit and export them in several formats. 
An example of this window is shown in the left panel of Figure 10. 

Together with the standard deviations of the azimuth and zenith distance residuals reported 
in the Astrometry submodule (see Section 3.5.4), these two plots can be used to assess the 
quality of the current astrometric solution. In particular, the magnitude of the residuals 
should remain smaller than the angular size of one pixel, which for the optics of the StAnD 
Meteor Camera Kits is approximately 7 arcminutes. 

3.5.10. Plot Photometry 

This menu item allows the user to plot the scatter between the instrumental and catalog 
magnitudes of the stars identified in the current calibration image (see Section 3.6.5), along 
with the calibration line (shown in red) defined by the current photometric solution (i.e. the 
zero-point and the magnitude scaling correction factor). Consequently, this item is available 
only when the Match stars option of the Stars menu is active (see Section 3.6.5). 

The plots are displayed in a new graphical window, from which the user can edit and export 
them in several formats. An example of this window is shown in the right panel of Figure 10. 

Together with the standard deviation of the magnitude residuals reported in the Astrometry 
submodule (see Section 3.5.4), this plot can be used to assess the quality of the current 
photometric solution. In particular, the scatter of the data points around the calibration line 
should not exceed 0.5 mag. 
 

Figure 9 – Screenshot of the main window of the PASCAL application, showing a calibration frame from the 
StAnD station in Nice (FRCA20 – Nice, Collège Frédéric Mistral) with the Show alt/az grid option of the 
Astrometry menu enabled. Grid labels are automatically displayed for each isoline and can be hidden using 
the Hide grid labels option in the same menu. The Orion constellation is visible in the upper-right portion of 
the zoom draw window.​
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Figure 10 – Screenshot of the astrometry and photometry plots produced by PASCAL for the calibration of the 
image shown in Figure 43. On the left panel, the astrometry plot displays the azimuth and zenith distance 
residuals (in arcminutes) between the measured and catalogued positions of the detected stars, illustrating 
the quality of the current astrometric solution. On the right panel, the photometry plot shows the relation 
between instrumental and catalog magnitudes for the detected stars, illustrating the magnitude conversion 
defined by the current photometric solution. The standard deviations of the residuals shown in these plots 
are reported in the corresponding boxes of the Astrometry submodule (see Figure 8).​

  

3.6. Stars Menu 

This menu becomes active only after a valid calibration image has been loaded into PASCAL. 
Through its items, the user can perform all operations related to the detection and 
identification of stars in the current image. The core functionality provided by this menu is 
the comparison between the measured positions of detected sources and the corresponding 
entries in the stellar catalog preloaded in PASCAL (see Section 2.1), using the current 
astrometric solution. For this reason, many of the items in this menu are interrelated with 
those of the Astrometry menu (see Section 3.5). 

3.6.1. Find Stars 

This menu item allows the user to automatically detect stars and, more generally, bright 
point-like sources, in the current image according to a set of configurable parameters (see 
Section 3.6.6). The positions of the detected stars are highlighted on both the main and 
zoom draw windows as small red circles. An example of the output of this function is 
reported in Figure 11. 

Before performing this operation, it is highly recommended to load and display both a mask 
and a superflat, in order to minimize the effects of nearby lights on the horizon, stray light, 
and hot pixels, all of which may in some cases mimic the signal of stars (see Section 3.4). If 
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these conditions are not met, a warning message will be displayed, informing the user that 
the results of the automatic star detection may be unreliable.  

While this option is active, stars will also be automatically detected when a new image is 
opened. If no stars are found, the menu item will be automatically deselected and a warning 
message will be displayed. 
 

Figure 11 – Screenshot of the main window of the PASCAL application, showing a calibration frame from the 
StAnD station in Nice (FRCA20 – Nice, Collège Frédéric Mistral), with the Find stars, Show catalog, Show IDs, 
and Match stars options of the Stars menu enabled. Detected stars are displayed as red circles, while catalog 
stars are shown as yellow circles. Catalog stars that have been successfully matched with detected star 
positions are highlighted in green. The identifier of each catalog star is displayed as a label on the upper-right 
side of the corresponding circle, in yellow or green depending on whether a match was found.​

 

3.6.2. Stars Table 

This menu item opens a table displaying the main properties of the detected stars (see 
Section 3.6.1) and their association with entries from the stellar catalog preloaded in 
PASCAL (see Section 3.6.3). An example of this table is shown in Figure 12. Each row 
corresponds to one detected star and is ordered from brightest to faintest according to the 
instrumental flux. From left to right, the table columns report: 

1.​ the progressive identification number of the star; 

2.​ the X-coordinate of the star centroid on the image, expressed in pixels; 

3.​ the Y-coordinate of the star centroid on the image, expressed in pixels; 

4.​ the instrumental flux of the star, expressed in ADU/s; 

5.​ the identifier of the stellar catalog entry matched to the star (abbreviated name of 
the constellation and star, or code if no proper name is available); 
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6.​ the azimuth of the matched catalog entry, expressed in degrees; 

7.​ the zenith distance of the matched catalog entry, expressed in degrees; 

8.​ the apparent magnitude of the matched catalog entry. 

Columns 5 - 8 are populated only if the Match stars item is enabled (see Section 3.6.5), and 
only for stars for which a valid catalog match has been found according to the current 
settings (see Section 3.6.6). 

3.6.3. Show Catalog 

This menu item allows the user to display the positions of stellar catalog entries on the 
current image according to the currently loaded astrometric solution (see Section 3.5). These 
positions represent where stars are expected to appear if the astrometric solution is 
sufficiently accurate and precise. Catalog positions are highlighted on both the main and 
zoom draw windows as small yellow circles. If a catalog entry is successfully matched with a 
detected star in the current image, the corresponding circles are displayed in green instead 
(see Section 3.6.5). An example of the output of this function is shown in Figure 11. 

3.6.4. Show IDs 

This menu item allows the user to display the identifier of each stellar catalog entry shown 
in the current image as a small text label, displayed in yellow (or in green if the catalog entry 
has been matched with a detected star). If the Show catalog option is selected (see Section 
3.6.3), the labels are shown on the upper-right side of the corresponding circles in the zoom 
draw window, only when the zoom level is lower than 4 (see Section 3.1.10).  
 

Figure 12 – Screenshot of the Stars table window of the PASCAL application, showing the results of the stars 
finding and catalog matching algorithm for a calibration frame from the StAnD station in Nice (FRCA20 – Nice, 
Collège Frédéric Mistral). 
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3.6.5. Match Stars 

This menu item allows the user to automatically match the positions of detected stars (see 
Section 3.6.1) in the image with entries from the stellar catalog preloaded in PASCAL (see 
Section 3.6.3). Consequently, this item is active only if both the Find stars and Show catalog 
options are currently selected. The matching is performed using a nearest-neighbour 
approach between the lists of detected and catalog star positions, based on their mutual 
distance and within a default maximum separation of 10 pixels, which can be adjusted in 
the settings (see Section 3.6.6).  

When a match is successful, the corresponding catalog star circle and label are displayed in 
green in both the main and zoom draw windows, and the associated catalog data are 
reported in the Stars table (see Section 3.6.2). An example of the result of this matching is 
shown in Figure 11 and Figure 12. 

3.6.6. Open Settings 

This menu item launches the Stars settings submodule of PASCAL, which allows the user to 
edit various parameters controlling the behaviour of the Stars menu and its main functions. 
A screenshot of this window is shown in Figure 13. All parameters are listed with a 
descriptive label and an editable textbox containing the corresponding value. When the user 
hovers the mouse over a label, a short description of the associated parameter is displayed in 
the lower part of the window, under the Settings description section. 
 

Figure 13 – Screenshot of the Stars settings submodule of the PASCAL application, showing the main 
configuration parameters for the Find stars, Show catalog, and Match stars options of the Stars menu. The 
user can edit these values in the corresponding textboxes and press Enter to apply the changes.​
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To modify one or more of these parameters, the user must edit their values in the 
corresponding textboxes and press Enter to apply the changes. The most important settings 
that can be adjusted are: 

●​ Hmin (under the Find configuration section): the minimum detection threshold for 
stars, expressed as a multiple of the root mean square of the sky background. 
Lowering this value (default is 16) allows fainter stars to be detected, while increasing 
it restricts detection to brighter stars. It is not recommended to set this parameter 
below 4. 

●​ Mag Max (under the Catalog selection section): the maximum apparent magnitude 
of catalog stars to be displayed when the Show catalog option is enabled. Increasing 
or decreasing this value (default is 3.5) includes fainter or brighter catalog stars, 
respectively. The user should note that the stellar catalog preloaded in PASCAL 
contains stars up to +6 apparent magnitude, while the brightest star, Sirius (α CMa), 
has a visual magnitude of about -1.5. 

●​ Rcorr (under the Match configuration section): the maximum allowed distance 
between detected and catalog stars for a valid match when using the Match stars 
option. Decreasing or increasing this value (default is 10 pixels) enforces a stricter or 
looser matching criterion, respectively. A recommended range for this parameter is 
between 5 and 20 pixels. 

3.7. Positions Menu 

This menu becomes active only after a valid detection frame has been loaded into PASCAL. 
Through its items, the user can perform operations related to the identification and 
positioning of the fireball in each frame of the recorded detection video. The starting point 
for this process is the information provided in the positions.txt file, which contains 
approximate fireball positions for each frame where it was detected, automatically 
computed by Freeture. The items in this menu allow the user to refine and improve the 
accuracy of these estimates. 

3.7.1. Load 

This menu item allows the user to load the list of fireball times and positions stored in the 
positions.txt file (see Section 3.2.2), which is automatically generated by the Freeture 
detection software. When this file is loaded for the first time, a new TXT file named 
newpositions.txt is created in the detection folder as a copy of positions.txt. All user 
modifications are saved in this new file, leaving the original positions file unchanged. 

The contents of the positions file are displayed in the Positions submodule of PASCAL, which 
opens automatically when this menu item is selected. The submodule consists of a table 
reporting, for each frame, the progressive frame number, the (x, y) position, the UTC time, 
and the box half-size (see Section 3.7.2). An example of the PASCAL main window together 
with the Positions submodule is shown in Figure 14. Clicking the item a second time will 
unload the positions list and close the Positions submodule of PASCAL. 
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Figure 14 – Screenshot of the main window of the PASCAL application showing a detection frame from the 
StAnD station in Nice (FRCA20 – Nice, Collège Frédéric Mistral), capturing a fireball observed on 3rd March 
2025 at 03:29:17 UT, with the Positions submodule activated (Load and Show box options enabled). In both 
the main and zoom draw windows, the fireball (x, y) position is marked by a small red circle. In the zoom 
draw window, the green box highlights the image region used for the S/N computation. The table displayed 
on the right lists the Positions table, reporting all frames included in the detection along with their relevant 
data. 

 
 

If the detection frame currently loaded in PASCAL is present in the positions list, a small red 
circle is displayed around the (x, y) position specified in the file (see Figure 14). The user can 
edit the current position by right-clicking on a new (x, y) location in the zoom draw window, 
provided that the zoom level is lower than 3 (see Section 3.1.10). If the user right-clicks on 
the exact position already displayed, the current frame is removed from the positions list. 

3.7.2. Auto Centre 

This menu item enables the automatic re-centering of the current fireball position. The 
computation is performed when the item is first activated and every time a new detection 
frame is loaded into PASCAL. Clicking this item a second time disables this functionality. The 
re-centering algorithm follows this specifications: 

●​ The new fireball position is computed using a barycentric calculation within a box 
centered on the current (x, y) position. If the current frame does not have an 
associated position, the computation starts from the temporally closest position 
available in the positions list;  

●​ The half-size of the box used to define the region on the image for the barycentric 
computation is specified in the last column of the positions table. This value can be 
adjusted using the Centering Box Dim slider located below the table in the Positions 
submodule window (see Figure 14). It is recommended to keep the box size large 
enough to fully enclose the fireball image. When loading a new frame, the box 
half-size is reset to the value specified in the table. Alternatively, the box size can be 
kept fixed across frames by enabling the Fix button located to the right of the slider. 
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●​ The algorithm evaluates the signal-to-noise (S/N) ratio at the computed position, 
defined as the ratio between the fireball flux and the root mean square of the sky 
background fluctuations. The resulting signal-to-noise ratio is displayed in the S/N 
textbox at the bottom of the Positions submodule window. If the S/N value falls 
below the minimum threshold (shown and editable in the adjacent Min textbox), the 
current frame is automatically removed from the positions list. 

3.7.3. Show Box 

This menu item allows the user to visualise the box used for automatic centering and S/N 
computation. The box is displayed in green on the zoom draw window (see Figure 14). 
Clicking this item a second time disables the centering box visualisation. 

3.8. Photometry Menu 

This menu allows the user to perform aperture photometry measurements on the image 
currently loaded in PASCAL. Aperture photometry is a standard technique used in astronomy 
to measure the flux (light intensity) of objects in images. In its standard implementation, 
aperture photometry requires the definition of three radii that determine the regions over 
which fluxes are computed: 

●​ Source aperture: the radius of the circular region, centered on the target source, over 
which the gross source flux is integrated.  

●​ Sky aperture: the inner and outer radii of an annular region concentric with the 
source aperture, used to estimate the average sky background flux per unit area. This 
background contribution is then scaled and subtracted to obtain the net source flux.  

In our case, the primary application of aperture photometry is the measurement of the light 
curve (LC) of a fireball recorded by one or more stations of the network. However, the same 
functionalities can also be used to measure the flux of stars in calibration images. 

3.8.1. Activate 

This menu item activates the Photometry submodule of PASCAL, by opening a new window, 
as shown in Figure 15. The submodule window includes a draw panel that displays the image 
region currently loaded for the aperture photometry computation. 

To start the measurement, the user can select the centre of the object directly from the 
zoom draw window in the main PASCAL interface by right-clicking on the desired (x, y) 
coordinates when the zoom level is lower than 3 (see Section 3.1.10). Once selected, the 
position will be displayed as a small pink circle in both the main and zoom draw windows.  

If the image currently loaded in PASCAL corresponds to a detection, the positions list has 
already been loaded, and the current frame is included in that list (see Section 3.7), the 
Photometry submodule will automatically open already centred on the estimated fireball 
position. In this case, the user should be aware that right-clicking on the zoom draw window 
will simultaneously update the fireball position and recenter the aperture photometry. 

In addition, it is also possible to store individual measurements in the lightcurve, which acts 
as a collection of flux and magnitude values as a function of time. This feature enables, for 
example, the visualization of the fireball lightcurve as a function of time. 
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Figure 15 – Screenshot of the Photometry submodule window of the PASCAL application, showing the details 
of the aperture photometry analysis for a single frame of a fireball observed on 3 March 2025 at 03:29:17 UT 
and recorded by the StAnD station in Nice (FRCA20 – Nice, Collège Frédéric Mistral). The screenshot also 
includes the index of all submodule components, as described in Section 3.8. 

 
 

The main elements of the Photometry submodule are the following: 

1)​ Aperture draw window: a draw panel displaying the square region of the currently 
loaded image used for the aperture photometry computation. The aperture radii 
cannot exceed half the size of this box. The central pixel is marked by a small red 
circle, while the source aperture is shown as a solid red circle and the inner and outer 
background apertures are shown as two dashed green circles. The user can right-click 
on any pixel within this image to change the centre used for the aperture photometry 
computation and move the corresponding box. 

2)​ Aperture photometry settings: a panel for configuring the settings of aperture 
photometry measurements. The user can select the box size from five available 
square dimensions (10, 20, 40, 80, and 160 pixels) and adjust the three aperture radii. 
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The radii can be modified either by entering values in the dedicated textboxes or by 
using the sliders located to the right of each textbox.  

3)​ Results: a panel displaying the results of the aperture photometry measurement for 
both the source and the sky background fluxes. Specifically, the panel reports the 
instrumental flux (respectively in ADU/s for the source and ADU/s/pixel for the sky 
background), the instrumental magnitude (respectively in mag and mag/pixel), and 
the apparent magnitude (respectively in mag and mag/arcsec²). The apparent 
magnitude is provided only if a valid astrometric and photometric solution is 
currently loaded in PASCAL (see Section 3.5).  

4)​ Lightcurve: a panel with three buttons to manage the measurements stored in the 
current lightcurve, which can be displayed in two separate plots for the source and 
sky background fluxes (see Section 3.8.2 and Section 3.8.3). From left to right: 

-​ Add to LC: add the current aperture photometry measurement to the 
lightcurve. If a measurement for the current image is already present in the 
lightcurve, it will be replaced. 

-​ Remove: remove from the lightcurve the aperture photometry measurement 
corresponding to the current image. 

-​ Clear: clear all measurements from the LC. 

5)​ Radial profile: a draw panel that displays the radial profile of the aperture 
photometry region, centred on the photometry centre selected by the user. The 
radial profile is computed as the average of the image pixel values at increasing radial 
distances, from 1 pixel up to half the size of the selected box. The three aperture radii 
are overplotted on the panel as vertical lines, using the same colours shown in the 
aperture draw window. The visualisation of the radial profile is useful for assessing 
the appropriateness of the chosen apertures: the source aperture should include all 
the signal from the selected source, while the sky background region should be 
sufficiently far from the source to avoid contamination from the source flux, nearby 
sources, or stray light.  

6)​ Description textbox: a textbox displaying a short description of the parameter or 
panel currently under the mouse cursor. A similar textbox is also provided below the 
lightcurve panel, displaying the (x, y) coordinates and the corresponding counts value 
of the pixel in the image shown in the aperture draw window. 

3.8.2. Plot Source LC 

This menu item allows the user to generate a plot of the source lightcurve currently stored 
in the memory of PASCAL. The plot is displayed in a new graphical window, from which the 
user can edit and export it in several formats. An example of this window is shown in the left 
panel of Figure 16. 

By default, the x-axis of the plot reports the time elapsed from the earliest image, expressed 
in seconds for detection frames and in minutes for calibration images. The y-axis displays 
the instrumental magnitude by default, or the calibrated apparent magnitude if a valid 
astrometric and photometric solution is currently loaded in PASCAL. Alternatively, the user 
can choose to display the instrumental flux using the dedicated option (see Section 3.8.4). 
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Figure 16 – Screenshot of the source (left panel) and sky background lightcurves (right panel) computed 
through the Photometry submodule of PASCAL for a fireball observed on 3 March 2025 at 03:29:17 UT and 
recorded by the StAnD station in Nice (FRCA20 – Nice, Collège Frédéric Mistral).  

 

3.8.3. Plot Sky LC 

This menu item allows the user to generate a plot of the sky background lightcurve currently 
stored in the memory of PASCAL. The plot has the same properties of the source lightcurve 
one, and an example of it is shown in the right panel of Figure 16. 

3.8.4. Plot Flux 

This menu item allows the user to choose whether to plot the instrumental flux (when the 
item is checked) or the instrumental/apparent magnitude (when the item is unchecked) for 
both the source and sky background lightcurves. 

3.8.5. Auto Add to LC 

This menu item allows the user to automatically add an aperture photometry measurement 
each time a measurement is performed, without requiring the user to click the dedicated 
button in the Photometry submodule. Clicking this item again disables this functionality. 

This option is particularly useful for computing the lightcurve of a fireball when used in 
conjunction with the Load item of the Positions menu (see Section 3.7.1). In this case, each 
time a new frame is opened, the centre used for the aperture photometry computation will 
automatically update to the fireball position specified in the positions list. To compute the 
complete fireball lightcurve, the user can then use the Play function of PASCAL to scroll 
through all detection frames (see Section 3.1.5). 

4. PASCAL - Analysis of Calibration Data 
The analysis of calibration data is typically performed to determine the astrometric and 
photometric solutions required to triangulate a fireball event observed by two or more 
PRISMA and/or StAnD stations. For this reason, the user must first identify and download 
calibration data acquired during a suitable night with good weather conditions for all 
cameras involved in the fireball recording. The PASCAL installer provides calibration and 
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fireball observational datasets for a few self-consistent cases, which can be used as tutorial 
examples. 

Based on the information provided in Chapter 2 and Chapter 3, the main steps required to 
complete the analysis of calibration data for a single station using PASCAL are summarised 
below: 

1.​ Load one calibration image acquired during the night under consideration using File > 
Open Capture (see Section 3.2.3). 

2.​ Adjust the dynamic range displayed in the image using the Image Cuts Min / Max 
sliders to properly visualise the stars (see Section 3.1.9). If needed, use the zoom 
panel to focus on a specific region of the image (see Section 3.1.8). 

3.​ Load an appropriate mask using Mask > Load Mask in order to remove disturbance 
lights (e.g. along the horizon) from the image (see Section 3.4.1). For the PASCAL 
tutorial data, example masks are provided in the PASCAL workspace (located by 
default in the user’s Documents folder) under settings/configuration. 

4.​ Identify a set of at least 10 - 20 images, preferably acquired without Moon 
contamination in the field of view, and compute a superflat based on these images 
using Mask > Compute flat (see Section 3.4.3). Then, load the resulting superflat 
using Mask > Load flat (see Section 3.4.4). 

5.​ Activate the astrometric functions using Astrometry > Activate (see Section 3.5.1).  

6.​ Detect the stars visible in the current image using Stars > Find stars (see Section 
3.6.1), and enable the visualisation of the stellar catalog using Stars > Show catalog  
(see Section 3.6.2). 

7.​ If an astrometric (and photometric) solution TXT file is already available, it can be 
loaded directly at this stage using Astrometry > Load solution (see Section 3.5.2). 
Pre-computed solutions for the PASCAL tutorial data are provided in the PASCAL 
workspace under settings/solutions. 

8.​ Use Astrometry > Edit solution (see Section 3.5.4) to manually adjust the solution 
parameters and improve the alignment between detected stars (red circles) and 
catalog stars (yellow circles).  

9.​ To confirm the associations, use Stars > Match stars (see Section 3.6.5), which 
highlights in green the catalog stars that have been successfully matched. Aim to 
obtain at least several tens of correctly matched stars, uniformly distributed across 
the field of view. 

10.​Optionally, refine the solution by selecting Astrometry > Fit solution (see Section 
3.5.5), which optimizes the astrometric and photometric parameters based on the 
current star matches. The quality of the resulting solution can be evaluated using 
Astrometry > Plot astrometry (see Section 3.5.9) and Astrometry > Plot photometry 
(see Section 3.5.10). 

11.​Browse through other calibration images of the station from the same night, in order 
to verify that the derived solution is appropriate for different frames. 

12.​Export the final solution using Astrometry > Save solution (see Section 3.5.6). The 
saved solution can later be loaded during the analysis of the fireball detection data. 
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5. PASCAL - Analysis of Fireball Data 

5.1. Detection Analysis 

Once all the stations involved in the detection of the fireball in analysis have been calibrated, 
as outlined in Chapter 4, it is possible to analyze the video of the fireball captured by each 
station to then combine these results and triangulate the three-dimensional trajectory of the 
fireball. To facilitate the implementation of this activity in the context of a classroom, we will 
consider a simplified version of the triangulation method, using only the astrometric data 
from the first and last frames of each detection video. 

Based on the information provided in Chapter 2 and Chapter 3, the main steps required to 
perform the analysis of a fireball detection for a single station using PASCAL are summarised 
below: 

1.​ Open a detection frame using File > Open detection (see Section 3.2.2). 

2.​ Load the fireball positions via Positions > Load (see Section 3.7.1), then navigate to 
the first frame listed in the table.  

3.​ Adjust the displayed dynamic range using the Image Cuts Min/Max sliders (see 
Section 3.1.9) to properly visualise the fireball. Use the zoom panel (see Section 
3.1.8) if needed to focus on a specific region of the image. 

4.​ Verify and adjust the bolide positions in each frame using Positions > Auto Centre 
(see Section 3.7.2), or manually by right-clicking over the fireball image centre on the 
zoom panel. Check before and after the positions and extend the list as required. 

5.​ Load the correct solution through Astrometry > Load solution (see Section 3.5.2). 

6.​ Browse to the first frame of the detection video and take note of the UTC time, 
azimuth and zenith distance at the fireball position at this frame using Astrometry > 
Show alt/az grid (see Section 3.5.7). Alternatively, click on the Calibrate button (see 
Section 3.1.16) and then hover the mouse on the fireball centre, taking notes of the 
coordinates displayed on the bottom of the main window (see Section 3.1.17). 

7.​ Repeat the same procedure for the last frame of the detection video, taking note of 
the final UTC time, azimuth and zenith distance angles. 

5.2. Triangulation 

Let us consider one of the examples provided as tutorial data in the PASCAL installer. These 
are the data of a fireball observed on 15 August 2025 at 01:30:30 UT by the StAnD stations in 
Muensterschwarzach (DEBY20) and in Weinheim (DEBW21). Figure 17 shows a 
reconstruction of the track of the fireball as seen by the two stations.  

Once the procedure described above has been completed for both the detections of this 
fireball, the following data should now be available and look like what is presented in Table 1. 

It should be noted that, in this case, the starting times for the two cameras are not aligned. 
Therefore, it is necessary to adjust the starting time of DEBW21 to match that of DEBY20. 
After this adjustment, the fireball astrometric data will be as of Table 2. 
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Figure 17 – Tracks of the fireball observed on 15 August 2025 at 01:30:30 UT by the StAnD stations in 
Muensterschwarzach (DEBY20 – Muensterschwarzach, Egbert-Gymnasium) and in Weinheim (DEBW21 - 
FTP01, FTP-Europlanet Office). 

 
 

Table 1 – Astrometric data of the fireball shown in Figure 17. 

DEBY20​
Muensterschwarzach # frame Time UTC Azimuth Zenith 

distance 

First 179 01:30:31.11 238° 49° 

Last 198 01:30:31.74 237° 62° 
     

DEBW21​
FTP01 # frame Time UTC Azimuth Zenith 

distance 

First 177 01:30:30.91 150° 17° 

Last 202 01:30:31.75 185° 32° 
 

 

Table 2 – Astrometric data of the fireball shown in Figure 17. 

DEBY20​
Muensterschwarzach # frame Time UTC Azimuth Zenith 

distance 

First 179 01:30:31.11 238° 49° 

Last 198 01:30:31.74 237° 62° 
     

DEBW21​
FTP01 # frame Time UTC Azimuth Zenith 

distance 

First 183 01:30:31.11 161° 19° 

Last 202 01:30:31.75 185° 32° 
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Figure 18 – Example of the map prepared for the triangulation of the fireball shown in Figure 17. The red 
lines represent the lines of sight for the first frame of the fireball detection, while the orange lines 
correspond to the last frame. The intersections of the red and orange lines define the trajectory of the fireball 
projected on the ground, and it is indicated by the black arrow. 

 
 

This operation can be done on a printed map, using a pencil, ruler, and goniometer. 
Alternatively, it can be performed on a computer, for example in a document or slides editor 
such as Microsoft PowerPoint, by using the Insert > Shapes > Lines function and adjusting 
each line’s angle in the Properties tab to match the corresponding azimuth angle. 

An example of this procedure is shown in Figure 18, based on the data reported in Table 2. 
The trajectory of the fireball projected on the ground (black arrow) is determined from the 
intersections of the lines of sight corresponding to the first frame (red lines) and the last 
frame (orange lines) of the detection. 
 

Up to this point, only the azimuth data have been used, while the zenith distance has been 
neglected. Starting from the projected ground trajectory, these data can now be exploited to 
estimate the initial and final heights of the fireball by means of a simple geometrical 
approximation, thus retrieving the full three-dimensional trajectory. To do so, we consider a 
triangle whose base is the segment connecting, for example, the position of the DEBW21 
station to the initial ground-projected coordinates of the fireball, as illustrated in Figure 19. 
The vertices, sides, and angles of the triangle shown in Figure 19 can be interpreted as 
illustrated in Table 3.  

The simplification lies in the fact that the triangle shown in Figure 19 is not strictly planar, but 
should instead be treated as a spherical triangle. However, for the purposes of this analysis, 
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and considering the level of precision achievable through triangulation performed graphically 
on a printed map, the bias introduced by this approximation is negligible in most cases. 
 

Figure 19 – Definition of the triangle used to estimate the altitude of the fireball, based on the triangulation 
results obtained from the map (see Figure 18) and on the measurement of the fireball zenith distance derived 
from the PRISMA and StAnD detection data and their astrometric analysis. 

 

Table 3 – Physical meaning of the vertices, sides and angles of the triangle depicted in Figure 19. 

VERTICES SIDES ANGLES 

A = position of the fireball in 
the atmosphere 

a = distance between the 
ground-projected fireball 
position and the camera 

α = zenith distance of the 
fireball measured on the 

detection frame 

B = position of the fireball 
projected on the ground 

b = total distance between 
the fireball and the camera 

β = 90° by definition 

C = position of the camera 
observing the fireball 

c = height of the fireball 
with respect to the ground 

γ = 90° - α = altitude of the 
fireball measured on the 

detection frame 
 
 

As evident from Table 3, the numerical values of all the angles of the triangle are already 
known. To fully solve the triangle, we can use the map in Figure 18 and scale it in order to 
measure side a, which in this case corresponds to the distance between the DEBW21 station 
(blue dot in Figure 18) and the starting point of the fireball trajectory projected onto the 
ground (the beginning of the black arrow in Figure 18). 

To be able to get the map scale into kilometers, one can use the distance between the two 
stations DEBY20 and DEBW21, which is 117 km (as reported in the text of Figure 18). More 
generally, this distance can be obtained using any online mapping tool, provided the latitude 
and longitude of the stations are known. On the printed A4 version of the map, the distance 
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between the two stations, measured with a ruler, is about 12.3 cm. Given that their true 
separation is 117 km, this corresponds to a map scale of 

 𝑠 =  12.3 𝑐𝑚
117 𝑘𝑚 ≃ 0. 1 𝑐𝑚

𝑘𝑚

Using this scale, the length of side a of the triangle, which measures about 3.7 cm on the 
map, corresponds to a ground distance of approximately 37 km. We can now fully resolve the 
triangle by applying, for example, the law of sines: 

 𝑎
sin α = 𝑏

sin β = 𝑐
sin γ

Using this relation, it is possible to derive a measure of side c, which represents the initial 
height of the fireball (Hi). In particular, knowing side a and the angles α (the initial zenith 
distance of the fireball measured from DEBW21, in this case 19°) and γ (the initial altitude of 
the fireball measured from DEBW21, in this case 71°), we obtain: 

 𝑐 = 𝑎 sin γ
sin α  → 𝐻

𝑖 
≃ 37 𝑘𝑚 sin 71°

sin 19° ≃ 107 𝑘𝑚 

The same procedure can be repeated to estimate the final height of the fireball (Hf), by 
considering the corresponding triangle whose base is the segment connecting the position of 
the DEBW21 station to the final ground-projected coordinates of the fireball on the map 
shown in Figure 18. From the map scale, the length of this base can be estimated to be 
approximately 45 km. Using the corresponding zenith distance angle of 32°, the final height 
of the fireball is then obtained as: 

 𝐻
𝑓 

≃ 45 𝑘𝑚 sin 58°
sin 32° ≃ 72 𝑘𝑚 

We can now describe the full cinematic of the fireball. It lighted up at an initial altitude of 
107 km over the city of Sinsheim on 15 August 2025 at 01:30:31.11 UT, travelling down to to 
a terminal altitude of 72 km in about 0.64 s, extinguishing at 01:30:31.74 UT over the city of 
Bruchsal, in the Baden-Württemberg land, Germany.  

5.3. Fireball speed 

It is then possible to estimate the average speed of the fireball by computing the total 
trajectory length travelled by the fireball and dividing it by the flight time. While the vertical 
distance can be calculated as Hi - Hf, the horizontal distance can be estimated by measuring, 
with a ruler, the length of the ground-projected trajectory on the map of Figure 18 (black 
arrow) and scaling it to kilometres as described above. In this case, it measures about 2.2 cm 
on the map, corresponding to approximately 22 km. 

 

The total trajectory length can therefore be calculated using Pythagoras’ theorem as: 

 𝐿 =  (22 𝑘𝑚)2 + (𝐻
𝑓

− 𝐻
𝑖
)2 ≃ 41 𝑘𝑚

Then, the average fireball speed can be estimated as: 

 𝑉 = 𝐿
∆𝑡 ≃ 42 𝑘𝑚

0.64 𝑠 ≃ 66 𝑘𝑚
𝑠
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5.4. Meteoroid pre-atmospheric mass 

A final step is to estimate the mass of the meteoroid that caused the fireball event by 
measuring its absolute magnitude , which represents the intrinsic luminosity of the ℳ
astronomical object (or, in this case, of the fireball) at a given reference distance. For 
meteors, this reference distance is conventionally taken as 100 km. Therefore, starting from 
the apparent magnitude m, the absolute magnitude can be computed as: 

 ℳ = 𝑚 + 5 log
10

( 𝑑
100 𝑘𝑚 )

An approximation that can be applied in this context involves the minimum absolute 
magnitude (or peak absolute magnitude) 0, which corresponds to the absolute magnitude ℳ
at the luminosity peak of the meteor. This approach is based on the work of Verniani (1973) 
and provides a rough estimate of the pre-atmospheric mass of the meteoroid (in kg units) as 
follows: 

 log
10

𝑀
∞

= 2. 63 − 0. 4ℳ
0

− 4log
10

𝑉
∞

where V∞ is the pre-atmospheric speed of the meteoroid (given in km/s units in the formula 
above), and can be approximated by the average fireball speed in our case. By using the 
Photometry submodule of PASCAL on the detection data of one station, we can compute the 
lightcurve of the bolide in terms of apparent magnitude. The lightcurve for the fireball under 
consideration computed from the data of the DEBW21 station is shown in Figure 20. 

For this fireball, the peak brightness occurred near the end of its luminous phase, with a 
recorded apparent magnitude of approximately -8. To determine the corresponding distance 
between the fireball and the DEBW21 station at that time, we can use the same triangle 
employed in calculating the final altitude of the fireball.  

Then, the distance can be calculated using Pythagoras’ theorem as: 

 𝑑 ≃ (45 𝑘𝑚)2 + (72 𝑘𝑚)2 ≃ 85 𝑘𝑚
 

Figure 20 – Lightcurve of the fireball observed on 15 August 2025 at 01:30:30 UT by the StAnD station in 
Weinheim (DEBW21 - FTP01, FTP-Europlanet Office), in units of apparent magnitude. 
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Therefore, the peak absolute magnitude can be estimated as: 

 ℳ
0

≃− 8 + 5 log
10

( 85 𝑘𝑚
100 𝑘𝑚 ) ≃− 8. 3

In this case, the difference between the apparent and absolute magnitude is quite small, 
since the fireball was observed at a distance of 85 km, which is close to the reference 
distance of 100 km.  

Finally, applying the formula of Verniani (1973), we can estimate the pre-atmospheric mass 
of the meteoroid as: 

 log
10

𝑀
∞

= 2. 63 − 0. 4 · (− 8. 3) − 4 · log
10

(66) ≃− 1. 3

 → 𝑀
∞

≃ 10−1.3 𝑘𝑔 ≃ 50 𝑔

Such a small meteoroid mass, combined with its high entry speed, makes it highly unlikely 
that a significant portion survived the atmospheric passage, and therefore that meteorites 
reached the ground. As a rule of thumb, meteorites can potentially be recovered if the 
following conditions are met: 

●​ A significant pre-atmospheric mass, typically at least a few kilograms; 

●​ A low entry speed, generally below 20–30 km/s; 

●​ A low terminal height, usually less than 30 km above the ground. 

If these conditions are met, the event may warrant further investigation, and it becomes 
worthwhile to perform a full data analysis to determine the meteoroid’s kinematic, physical, 
and orbital properties with greater precision and accuracy. In cases where it is estimated 
that a final mass exceeding a few tens of grams may have reached the ground, the potential 
meteorite recovery area, known as strewn field, is calculated. This computation takes into 
account the atmospheric conditions at the time, particularly the profiles of wind speed and 
direction in the fall area, derived from meteorological data. 
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